Microsoft®

Office 2007

‘New Features’
# Table of Contents

**Excel Fundamentals** ............................................................................................................................................... 7  
Starting Excel 2007 ................................................................................................................................................ 8  
What's New in Excel 2007 ................................................................................................................................ 9  
Understanding the Excel Program Screen ........................................................................................................ 10  
Understanding the Ribbon ................................................................................................................................. 12  
Using the Office Button and Quick Access Toolbar ...................................................................................... 13  
Using Keyboard Commands ............................................................................................................................. 14  
Using Contextual Menus and the Mini Toolbar ............................................................................................... 15  
Using Help ......................................................................................................................................................... 16  
Exiting Excel 2007 ............................................................................................................................................. 18  

**Outlook Fundamentals** ....................................................................................................................................... 19  
Starting Outlook 2007 ...................................................................................................................................... 20  
What's New in Outlook 2007 .......................................................................................................................... 21  
Understanding the Outlook 2007 Program Screen ....................................................................................... 23  
Understanding Items ....................................................................................................................................... 25  
Understanding the Message Window ............................................................................................................. 26  
Understanding the Ribbon .............................................................................................................................. 27  
Using the Office Button and Quick Access Toolbar .................................................................................... 28  
Using the Navigation Pane ............................................................................................................................ 29  
Using the To-Do Bar ....................................................................................................................................... 31  
Using Menus and Toolbars ............................................................................................................................. 32  
Using Keyboard Commands ........................................................................................................................... 34  
Using Help ......................................................................................................................................................... 35  
Exiting Outlook 2007 ....................................................................................................................................... 37  

**PowerPoint Fundamentals** .............................................................................................................................. 38  
Starting PowerPoint 2007 .............................................................................................................................. 39  
What’s New in PowerPoint 2007? .................................................................................................................... 40  
Understanding the PowerPoint 2007 Program Screen .............................................................................. 41  
Understanding the Ribbon ............................................................................................................................ 42  
Using the Office Button and the Quick Access Toolbar ............................................................................. 43  
Using Keyboard Commands .......................................................................................................................... 44  
Using Contextual Menus and the Mini Toolbar ........................................................................................... 45  
Using Help ......................................................................................................................................................... 46  
Exiting PowerPoint 2007 ............................................................................................................................... 48  

**Word Fundamentals** ........................................................................................................................................ 50  
Starting Word 2007 ........................................................................................................................................ 51  
What's New in Word 2007 ............................................................................................................................ 52  
Understanding the Word 2007 Program Screen .......................................................................................... 53  
Understanding the Ribbon ............................................................................................................................ 54  
Using the Office Button and Quick Access Toolbar .................................................................................. 55  
Using Keyboard Commands .......................................................................................................................... 56  
Using Contextual Menus and the Mini Toolbar ........................................................................................... 57  
Using Help ......................................................................................................................................................... 58  
Exiting Word 2007 .......................................................................................................................................... 60  

**Index** .................................................................................................................................................................. 61
Introducing CustomGuide Courseware

Thank you for choosing CustomGuide courseware as the solution to your training needs. A proven leader in the computer training industry, CustomGuide has been the key to successful training for thousands of students and instructors across the globe.

This manual is designed for computer users of all experience levels. Novice users can use it to learn skills such as creating formulas, while advanced users can use it to create and format charts.

All this information is quickly accessible. Lessons are broken down into basic step-by-step instructions that answer “how-to” questions in minutes. You can print a complete 300-page training manual or a single page of instructions.

Here’s how a CustomGuide manual is organized:

**Chapters**
Each manual is divided into several chapters. Aren’t sure if you’re ready for a chapter? Look at the table of contents that appears at the beginning of each chapter. It will tell you the name of each lesson and subtopic included in the chapter.

**Lessons**
Each chapter contains lessons on related topics. Each lesson explains a new skill or topic and contains an exercise and exercise file to give you hands-on-experience. These skills can also be practiced using CustomGuide Online Learning.

**Review**
A review is included at the end of the manual. Use these quiz questions and answers to assess how much you’ve learned.

What People Are Saying

“I have saved hundreds of hours of design time by just picking and choosing what I want from the courseware.”

— Stephanie Zimmerman
Lancaster County Library

“We have been able to customize our training sessions on all Microsoft Office products, at all levels. The ROI of these guides is great.”

— Dawn Calvin
Las Virgenes Municipal Water District

“All in all, the friendliest, most open and easy to understand tutorial of its type that I’ve ever seen.”

— W. Boudville
Amazon.com

“…curriculum that is of high quality, student friendly, and adaptable to the audience.”

— Sherrill Wayland
St. Charles Community College

“…a nice training option for almost any need. Their complete Microsoft Office package is by far the best deal on the market.”

— Technical Assistance Program
Purdue University

“Any instructor teaching classes on Windows or Microsoft Office will definitely want to give serious consideration to this important collection of titles that will definitely fit well into their classroom learning.”

— Dale Farris
Golden Triangle PC Club

“The materials are exceptional – I am so excited about using them! Thanks to you and your team for doing this wonderful work!”

— Shannon Coleman
Learning Post Ltd.
Courseware Features

Working with Shapes and Pictures

Positioning Pictures

Whenever you insert a graphic into a document, it is inserted inline with text by default. This means that the text in the document moves in order to accommodate the graphic. This lesson will show you how to adjust text wrapping and how to use the grid to position objects.

Tips

✓ If you want to use a graphic with other graphics or objects, they must be on a drawing canvas. See the lesson on inserting Shapes for more information.

Adjust text wrapping

To adjust how text reacts to the objects in your documents, change the object’s text wrapping.

1. Double-click the object whose text wrapping you wish to adjust.
   The Format contextual tab appears on the Ribbon.

2. Click the Text Wrapping button in the Arrange group.
   A list of text wrapping styles appears. Take a look at the Text Wrapping Styles table for a description of each style.

3. Select a text wrapping style from the list.
   The text wrapping style is applied to the image.

Other Ways to Adjust Text Wrapping:

- Right-click the image, point to Text Wrapping in the contextual menu, and select an option from the submenu.

To display/hide the grid

Just like the graph paper you used to use in geometry class, the grid consists of horizontal and vertical lines that help you draw and position objects.

1. Click the View tab on the Ribbon.

2. Click the Gridlines check box in the Show/Hide group.
   Horizontal and vertical gridlines appear on the page.

Other Ways to Display the Grid:

- Press <Shift> + <F9>, or click the Format contextual tab on the Ribbon, click the Align button in the Arrange group, and select View Gridlines from the list.


Table: Text Wrapping Styles

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Line with Text</td>
<td>This places the object at the starting point in a line of text in the document. The object remains on the same layer as the text.</td>
</tr>
<tr>
<td>Square</td>
<td>Wraps text around all sides of the square bounding box for the selected object.</td>
</tr>
<tr>
<td>Tight</td>
<td>Wraps text tightly around the edges of the actual image (instead of wrapping around the object’s bounding box).</td>
</tr>
<tr>
<td>Behind Text</td>
<td>This removes text wrapping and puts the object behind text in a document. The object floats on its own layer.</td>
</tr>
<tr>
<td>In Front of Text</td>
<td>This removes text wrapping and puts the object in front of text in a document. The object floats on its own layer.</td>
</tr>
<tr>
<td>Top and Bottom</td>
<td>Wraps text around the top and bottom of the object, leaving the area to the right and left of the object clear.</td>
</tr>
<tr>
<td>Through</td>
<td>Similar to the Tight style, this style wraps text throughout the image.</td>
</tr>
</tbody>
</table>

Figure: A document with the grid displayed.

Lesson: Working with Shapes and Pictures

Exercise

Exercise File: AmericanHistory7-3.docx

Exercise: Select the header row containing the month labels, the Income row, the Total Exp. Row, and the Net Inc. row (use the Ctrl key to select multiple rows). Create a 2-D Clustered Column chart.

Table 7-2: Text Wrapping Styles

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Line with Text</td>
<td>This places the object at the starting point in a line of text in the document. The object remains on the same layer as the text.</td>
</tr>
<tr>
<td>Square</td>
<td>Wraps text around all sides of the square bounding box for the selected object.</td>
</tr>
<tr>
<td>Tight</td>
<td>Wraps text tightly around the edges of the actual image (instead of wrapping around the object’s bounding box).</td>
</tr>
<tr>
<td>Behind Text</td>
<td>This removes text wrapping and puts the object behind text in a document. The object floats on its own layer.</td>
</tr>
<tr>
<td>In Front of Text</td>
<td>This removes text wrapping and puts the object in front of text in a document. The object floats on its own layer.</td>
</tr>
<tr>
<td>Top and Bottom</td>
<td>Wraps text around the top and bottom of the object, leaving the area to the right and left of the object clear.</td>
</tr>
<tr>
<td>Through</td>
<td>Similar to the Tight style, this style wraps text throughout the image.</td>
</tr>
</tbody>
</table>

Figure: A document with the grid displayed.
Microsoft Excel is a powerful spreadsheet program that allows you to make quick and accurate numerical calculations and helps you to make your data look sharp and professional. The uses for Excel are limitless: businesses use Excel for creating financial reports, scientists use Excel for statistical analysis, and families use Excel to help manage their investment portfolios.

For 2007, Excel has undergone a major redesign. If you’ve used Excel before, you’ll still be familiar with much of the program’s functionality, but you’ll notice a completely new user interface and many new features that have been added to make using Excel more efficient.

This chapter is an introduction to working with Excel. You’ll learn about the main parts of the program screen, how to give commands, use help, and about new features in Excel 2007.
Starting Excel 2007

In order to use a program, you must start—or launch—it first.

Windows XP

1. Click the Windows Start button.
   The Start menu appears.

2. Point to All Programs.
   A menu appears. The programs and menus listed here will depend on the programs installed on your computer.

3. Point to Microsoft Office.

   The Excel program screen appears.

   Trap: Depending on how your computer is set up, the procedure for starting Excel 2007 might be a little different from the one described here.

Tips

✓ If you use Excel 2007 frequently, you might consider pinning it to the Start menu. To do this, right-click Microsoft Office Excel 2007 in the All Programs menu and select Pin to Start Menu.

Exercise

- Exercise File: None required.
- Exercise: Start the Microsoft Office Excel 2007 program.
What’s New in Excel 2007

Excel 2007 is very different from previous versions. The table below gives you an overview of what to expect.

Table 1-1: What’s New in Excel 2007

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New user interface</td>
<td>The new results-oriented user interface (UI) is the most noticeable change in Excel 2007. Traditional menus and toolbars have been replaced by the Ribbon, a single mechanism that makes all the commands needed to perform a task readily available.</td>
</tr>
<tr>
<td>Live Preview</td>
<td>Allows you to preview how a formatting change will look before applying it. Simply point to the selection on the Ribbon or Mini Toolbar and Excel 2007 shows you a preview of what your worksheet would look like if the selected changes were applied.</td>
</tr>
<tr>
<td>XML compatibility</td>
<td>The new Excel XML format (.xlsx) is much smaller in file size and makes it easier to recover damaged or corrupted files. Files based on XML have the potential to be more robust and integrated with information systems and external data.</td>
</tr>
<tr>
<td>Improved styles and themes</td>
<td>Predefined styles and themes let you change the overall look and feel of a worksheet in just a few clicks. With Office themes, you can apply predefined formatting to workbooks and then share them with Word and PowerPoint to give your Office documents a unified look. You can even create your own corporate theme. Styles can be used to format specific items in Excel, such as tables and charts.</td>
</tr>
<tr>
<td>SmartArt</td>
<td>The new SmartArt graphics feature offers new diagram types and more layout options, and lets you convert text such as a bulleted list into a diagram.</td>
</tr>
<tr>
<td>Save as PDF</td>
<td>Now you can install an Excel add-in that allows you to save a workbook as a PDF without using third-party software. PDF format allows you to share your worksheet with users on any platform.</td>
</tr>
<tr>
<td>Document Inspector</td>
<td>Removes comments, tracked changes, metadata (document history such as the author and editors) and other information that you don’t want to appear in the finished worksheet.</td>
</tr>
<tr>
<td>Digital Signature</td>
<td>Adding a digital signature to a workbook prevents inadvertent changes, ensuring that your content cannot be altered.</td>
</tr>
<tr>
<td>Better sharing capabilities</td>
<td>Microsoft Office SharePoint Server 2007 makes it easier to share and manage worksheets from within Excel.</td>
</tr>
<tr>
<td>Better conditional formatting</td>
<td>Conditional formatting allows you to analyze Excel data with just a few clicks. You can apply gradient colors, data bars, and icons to cells to visually represent relationships between your data.</td>
</tr>
<tr>
<td>Easier formula writing</td>
<td>An expandable formula bar and Function AutoComplete are among several features that make formula writing easier in Excel 2007.</td>
</tr>
<tr>
<td>Enhanced sorting and filtering</td>
<td>Now you can sort data by color and by up to 64 levels. You can also filter by color or date, display more than 1000 items in the AutoFilter drop-down list, filter by multiple items, and filter PivotTable data.</td>
</tr>
<tr>
<td>Improved tables (formerly Excel lists)</td>
<td>Among the improvements to tables: table header rows can be turned on or off; calculated columns have been added so you only have to enter a formula once; AutoFilter is turned on by default; and structured references allow you to use table column header names in formulas in place of cell references.</td>
</tr>
<tr>
<td>Better charts</td>
<td>Visual chart element pickers allow you to quickly edit chart elements such as titles and legends, OfficeArt allows you to format shapes with modern-looking 3-D effects, and clearer lines and charts make charts easier to read. In addition, sharing charts with other Office programs is easier than ever, because Word and PowerPoint now share Excel’s chart features.</td>
</tr>
<tr>
<td>New PivotTable interface</td>
<td>With the new PivotTable user interface, dragging data to drop zones has been replaced by clicking the fields you want to see. You can now undo PivotTable actions, expand or collapse parts of the PivotTable with plus and minus drill-down indicators, and sort and filter data using simple buttons.</td>
</tr>
<tr>
<td>Easier connection to external data</td>
<td>Quicklaunch allows you to select from a list of data sources that your administrator has made available, instead of having to know the server or database names, and a connection manager allows you to view all the connections in a workbook.</td>
</tr>
<tr>
<td>New Page Layout view</td>
<td>With a new Page Layout view, you can see how your worksheet will look in a printed format while you work.</td>
</tr>
</tbody>
</table>

Exercise

- **Exercise File:** None required.
- **Exercise:** Review the new features in Microsoft Office Excel 2007.
Understanding the Excel Program Screen

The Excel 2007 program screen may seem confusing and overwhelming at first. This lesson will help you become familiar with the Excel 2007 program screen as well as the new user interface.

Exercise Notes

- Exercise File: None required.
- Exercise: Understand and experiment with the different parts of the Microsoft Office Excel 2007 screen.

Office Button: Replaces the File menu found in previous versions of Excel.

Quick Access Toolbar: Contains common commands such as Save and Undo. You can add more commands as well.

Title bar: Displays the name of the workbook you are currently working on and the name of the program you are using.

Close button: Click the close button in the Title bar to exit the Excel program entirely, or click the close button in the Ribbon to close only the current workbook.

Ribbon: The tabs and groups on the Ribbon replace the menus and toolbars found in previous versions of Excel.

View buttons: Use these buttons to quickly switch between Normal, Page Layout, and Page Break Preview views.

Worksheet tabs: Workbooks have three worksheets by default. You can move from one worksheet to another by clicking the worksheet tabs.

Status bar: Displays messages and feedback.

Name box: Displays the active cell address or object name.

Row and column headings: Cells are organized and referenced by row and column headings (for example, cell A1).
| Scroll bars: Use the vertical and horizontal scroll bars to view different parts of the worksheet. | Active cell: You can enter or edit data in the active cell. |
| Zoom slider: Click and drag the slider to zoom in or out of a window. You can also use the + and – buttons. | Formula Bar: Allows you to view, enter, and edit data in the active cell. The Formula Bar displays the contents of the cell, such as values or formulas. |
Understanding the Ribbon

Excel 2007 provides easy access to commands through the Ribbon, which replaces the menus and toolbars found in previous versions of Excel. The Ribbon keeps commands visible while you work instead of hiding them under menus or toolbars.

The Ribbon is made up of three basic components:

Tabs

Commands are organized into tabs on the Ribbon. Each tab contains a different set of commands. There are three different types of tabs:

- **Command tabs**: These tabs appear by default whenever you open the Excel program. In Excel 2007, the Home, Insert, Page Layout, Formulas, Data, Review, and View tabs appear by default.

- **Contextual tabs**: Contextual tabs appear whenever you perform a specific task and offer commands relative to only that task. For example, whenever you insert a table, the Design tab appears on the Ribbon.

- **Program tabs**: If you switch to a different authoring mode or view, such as Print Preview, program tabs replace the default command tabs that appear on the Ribbon.

Groups

The commands found on each tab are organized into groups of related commands. For example, the Font group contains commands used for formatting fonts. Click the Dialog Box Launcher ( ) in the bottom-right corner of a group to display even more commands. Some groups also contain galleries that display several formatting options.

Buttons

One way to issue a command is by clicking its button on the Ribbon. Buttons are the smallest element of the Ribbon.

Tips

- You can hide the Ribbon so that only tab names appear, giving you more room in the program window. To do this, double-click the currently displayed command tab. To display the Ribbon again, click any tab.

- Based on the size of the program window, Excel changes the appearance and layout of the commands within the groups.

Exercise

- **Exercise File**: None required.
- **Exercise**: Click each tab on the Ribbon to view its commands.

Figure 1-3: Ribbon elements.

Figure 1-4: Hiding the Ribbon gives you more room in the program window.
Using the Office Button and Quick Access Toolbar

Near the Ribbon at the top of the program window are two other tools you can use to give commands in Excel 2007: The Office Button and the Quick Access Toolbar.

Office Button

The Office Button appears in the upper-left corner of the program window and contains basic file management commands including New, which creates a new file; Open, which opens a file; Save, which saves the currently opened file; and Close, which closes the currently opened file.

Tips

✓ The Office Button replaces the File menu found in previous versions of Excel.

Quick Access Toolbar

The Quick Access Toolbar appears to the right of the Office Button and provides easy access to the commands you use most frequently. By default, the Save, Undo and Redo buttons appear on the toolbar; however, you can customize this toolbar to meet your needs by adding or removing buttons. To customize it:

- Click the Customize Quick Access Toolbar button at the end of the Quick Access Toolbar and select the commands you want to add or remove.

Tips

✓ You can change where the Quick Access Toolbar appears in the program window. To do this, click the Customize Quick Access Toolbar button at the end of the Quick Access Toolbar. Select Show Below the Ribbon or Show Above the Ribbon, depending on the toolbar’s current location.

Exercise

- Exercise File: None required.
- Exercise: Click the Office Button to open it. Move the Quick Access Toolbar below the Ribbon, then move it back above the Ribbon.

Figure 1-5: The Office Button menu.

Figure 1-6: The Quick Access Toolbar.
Using Keyboard Commands

Another way to give commands in Excel 2007 is using the keyboard. There are two different types of keyboard commands in Excel 2007: keystroke shortcuts and Key Tips.

Keystroke shortcuts

Without a doubt, keystroke shortcuts are the fastest way to give commands in Excel 2007. They’re especially great for issuing common commands, such as saving a workbook.

In order to issue a command using a keystroke shortcut, you simply press a combination of keys on your keyboard. For example, rather than clicking the Copy button on the Ribbon to copy a cell, you could press and hold the copy keystroke shortcut, <Ctrl> + <C>.

Key Tips

New in Excel 2007, Key Tips appear whenever you press the <Alt> key. You can use Key Tips to perform just about any action in Excel, without ever having to use the mouse.

To issue a command using a Key Tip, first press the <Alt> key. Tiny letters and numbers, called badges, appear on the Office Button, the Quick Access Toolbar, and all of the tabs on the Ribbon. Depending on the tab or command you want to select, press the letter or number key indicated on the badge. Repeat this step as necessary until the desired command has been issued.

Exercise

- **Exercise File:** None required.
- **Exercise:** Memorize some common keystroke shortcuts. Then view Key Tips in the program.

<table>
<thead>
<tr>
<th>Table 1-2: Common Keystroke Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Ctrl&gt; + &lt;O&gt;</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;N&gt;</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;S&gt;</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;P&gt;</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;B&gt;</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;I&gt;</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;C&gt;</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;X&gt;</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;V&gt;</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;Home&gt;</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;End&gt;</td>
</tr>
</tbody>
</table>

Figure 1-7: Press the <Alt> key to display Key Tips.
Using Contextual Menus and the Mini Toolbar

There are two tools that you can use in Excel 2007 that make relevant commands even more readily available: contextual menus and the Mini Toolbar.

**Contextual menus**

A contextual menu displays a list of commands related to a specific object or area. To open a contextual menu:

1. Right-click an object or area of the worksheet or program screen.
   
   A contextual menu appears, displaying commands that are relevant to the object or area that you right-clicked.

2. Select an option from the contextual menu, or click anywhere outside the contextual menu to close it without selecting anything.

**The Mini Toolbar**

New in Excel 2007 is the **Mini Toolbar**, which appears when you select text or data within a cell or the formula bar, and contains common text formatting commands. To view the Mini Toolbar:

1. Select text or data within a cell or the formula bar.
   
   The Mini Toolbar appears above the text or data you selected.

   **Trap:** Sometimes the Mini Toolbar can be hard to see due to its transparency. To make the Mini Toolbar more visible, point to it.

   **Tip:** A larger version of the Mini Toolbar also appears along with the contextual menu whenever you right-click an object or area.

2. Click the desired command on the Mini Toolbar or click anywhere outside the Mini Toolbar to close it.

   **Tip:** If you don’t want the Mini Toolbar to appear every time, click the Office Button and click the Excel Options button. Click the Personalize category, uncheck the Show Mini Toolbar on selection check box, and click OK.

Exercise

- **Exercise File:** None required.
- **Exercise:** Open a contextual menu in the main area and other parts of the program window.
Using Help

When you don’t know how to do something in Excel 2007, look up your question in the Excel Help files. The Excel Help files can answer your questions, offer tips, and provide help for all of Excel’s features.

Search for help

1. Click the Microsoft Office Excel Help button on the Ribbon.
   The Excel Help window appears.
   Other Ways to Open the Help window: Press <F1>.

2. Type what you want to search for in the “Type words to search for” box and press <Enter>.
   A list of help topics appears.

3. Click the topic that best matches what you’re looking for.
   Excel displays information regarding the selected topic.

Browse for help

1. Click the Microsoft Office Excel Help button on the Ribbon.
   The Excel Help window appears.

2. Click the category that you want to browse.
   The topics within the selected category appear.

3. Click the topic that best matches what you’re looking for.
   Excel displays information regarding the selected topic.

Choose the Help source

If you are connected to the Internet, Excel 2007 retrieves help from the Office Online database by default. You can easily change this to meet your needs.

1. Click the Search button list arrow in the Excel Help window.
   A list of help sources appears.

2. Select an option from the list.
   Now you can search that source.

Exercise

• Exercise File: None required.
• Exercise: Search the term “formatting numbers”. Search the term again using “Content from this computer” only. Browse topics in the “Worksheet and Excel table basics” category of Help.

Figure 1-10: The Excel Help window.

Table 1-3: Help buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Click here to move back to the previous help topic.</td>
</tr>
<tr>
<td>Forward</td>
<td>Click here to move forward to the next help topic.</td>
</tr>
<tr>
<td>Home</td>
<td>Click here to return to the Help home page.</td>
</tr>
<tr>
<td>Print</td>
<td>Click here to print the current help topic.</td>
</tr>
<tr>
<td>Change Font Size</td>
<td>Click here to change the size of the text in the Help window.</td>
</tr>
<tr>
<td>Show Table of Contents</td>
<td>Click here to browse for help using the Table of Contents.</td>
</tr>
<tr>
<td>Keep On Top</td>
<td>Click here to layer the Help window so that it appears behind all other Microsoft Office programs.</td>
</tr>
</tbody>
</table>
The Fundamentals

Tips

- When a standard search returns too many results, try searching offline to narrow things down a bit.

- Office 2007 offers enhanced ScreenTips for many buttons on the Ribbon. You can use these ScreenTips to learn more about what a button does and, where available, view a keystroke shortcut for the command. If you see the message “Press F1 for more help”, press <F1> to get more information relative to that command.

- When you are working in a dialog box, click the Help button (2) in the upper right-hand corner to get help regarding the commands in the dialog box.
Exiting Excel 2007

When you’re finished using Excel 2007, you should exit it. Exiting a program closes it until you need to use it again.

1. Click the Office Button.

2. Click the Exit Excel button.
   The Excel program closes.

Other Ways to Exit Excel:
   Click the Close button in the title bar.

Tips
✓ Having too many programs open at a time could slow down your computer, so it’s a good idea to exit all programs that aren’t being used.
Welcome to Microsoft Outlook 2007!

Microsoft Outlook lets you send and receive e-mail messages, schedule appointments, and organize your contacts and addresses. It also reminds you of tasks you need to complete.

This chapter introduces the Outlook fundamentals. Besides learning how to start and exit the Outlook program, you will learn how to find your way around the Outlook screen and item windows. You will also learn how to use keyboard commands and access Outlook’s help features. Let’s get started!
Starting Outlook 2007

In order to use a program, you must start—or launch—it first.

Windows XP or Vista

1. Click the Windows Start button.
   The Start menu appears.

2. Select All Programs.
   The programs and menus listed here will depend on the programs installed on your computer.

3. Select Microsoft Office.

   The Outlook program screen appears.

Trap: Depending on how your computer is set up, the procedure for starting Outlook 2007 might be a little different from the one described here.

Tips

✓ For quicker access, you might consider pinning the Outlook program to the Start menu. To do this, right-click Microsoft Office Outlook 2007 in the All Programs menu and select Pin to Start Menu.
What’s New in Outlook 2007

Outlook 2007 is somewhat different from previous versions. Table 3-1: What’s New in Outlook 2007 lets you know what to expect.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New user interface</td>
<td>Outlook 2007 has a new results-oriented user interface (UI). While traditional menus and toolbars remain in the main program screen, they have been replaced in item screens by the Ribbon, a single mechanism that makes all the commands needed to perform a task readily available.</td>
</tr>
<tr>
<td>Instant Search</td>
<td>This feature, which must first be activated by downloading a program from Microsoft’s Web site, allows you to search for key words in all of your message content and folders. Results appear immediately while the search continues to run. Keywords are then highlighted in the search results for easy identification.</td>
</tr>
<tr>
<td>Color Categories</td>
<td>You can quickly add color categories to e-mails and other items to distinguish them from one another or to assign them to a particular project. You can also sort items by color categories.</td>
</tr>
<tr>
<td>Preview Attachments</td>
<td>Now you can preview attachments right in the Reading Pane without actually opening them.</td>
</tr>
<tr>
<td>Flags</td>
<td>When you flag e-mails for follow-up, they will now appear in Tasks as items in the To-Do List, on the Calendar, and in the To-Do Bar, in addition to in your e-mail Inbox.</td>
</tr>
<tr>
<td>To-Do Bar</td>
<td>The To-Do Bar can be displayed next to the Reading Pane and is a convenient way to keep tabs on your calendar and appointments, as well as your task list, all in one place while still working with e-mail.</td>
</tr>
<tr>
<td>Task Integration</td>
<td>Tasks are listed below the day and week calendar views. Simply drag a task up onto the calendar to allot time in your schedule for that task. Uncompleted tasks roll forward to the next day.</td>
</tr>
<tr>
<td>Improved Scheduling</td>
<td>Exchange Server 2007 reviews attendees’ schedules and recommends the best meeting time and place. If changes are made to meeting details, attendees receive an update with the changes highlighted, rather than having to reaccept the meeting.</td>
</tr>
<tr>
<td>RSS Feeds</td>
<td>Really Simple Syndication (RSS) feeds are now available in Outlook. With RSS feeds, you can receive frequently updated information such as news and blogs from multiple Web sources right in Outlook.</td>
</tr>
<tr>
<td>Auto Account Setup</td>
<td>This feature simplifies the process of adding Outlook accounts. Instead of needing to enter a server name or other confusing information, you simply need to know your e-mail account name and password.</td>
</tr>
<tr>
<td>Calendar Sharing</td>
<td>Now you can send a snapshot of your calendar to others by e-mail, subscribe to calendars that are shared over the Internet, and compare multiple peoples’ calendars in an overlay mode. You can also share calendars by publishing them to Office Online.</td>
</tr>
<tr>
<td>Electronic Business Cards</td>
<td>Electronic Business Cards allow you to customize your contact information with logos and photos and then easily share them as an e-mail attachment or as part of your e-mail signature.</td>
</tr>
<tr>
<td>Save as PDF or XPS File</td>
<td>Now you can install an Outlook add-in—no third-party software necessary—that allows you to export Outlook files to these formats, which are good for preserving document formatting and sharing files.</td>
</tr>
<tr>
<td>Out of Office Assistant</td>
<td>When this feature is turned on, a notice now appears in the status bar instead of in a dialog box at startup. Also, if you use Exchange Server 2007 you can set up Out of Office times in advance and specify different messages for recipients inside and outside your organization.</td>
</tr>
<tr>
<td>Voice Mail and Fax Services</td>
<td>With Exchange Server 2007, you can receive voice mails and faxes right in your e-mail Inbox.</td>
</tr>
<tr>
<td>E-mail Postmark</td>
<td>This technology asks the computer that’s sending you an e-mail to solve a puzzle to prove the message’s legitimacy. This roadblock makes it difficult for spammers to send mass e-mails.</td>
</tr>
<tr>
<td>Improved Security</td>
<td>Better Junk E-mail filtering keeps more unwanted messages from reaching your Inbox; Outlook anti-phishing features disable suspicious links in messages and warn you of threatening sites; Exchange Server 2007 allows you to manage access to e-mail folders; improved Information Rights Management (IRM) helps prevent unauthorized access to e-mails; and security settings can be managed in Microsoft Office’s new Trust Center.</td>
</tr>
</tbody>
</table>

Exercise

- Exercise File: None required.
- Exercise: Review the new features in Microsoft Office Outlook 2007.
### Table 3-1: What’s New in Outlook 2007

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Diagnostics and Recovery</strong></td>
<td>Microsoft Office Diagnostics runs tests to help identify and solve problems that are causing your computer to crash. Outlook 2007 also has improved program recovery capabilities. If Outlook 2007 closes abnormally, it tries to restore windows to the way they were before the crash. These features replace Office 2003’s Detect and Repair and Application Recovery features.</td>
</tr>
<tr>
<td><strong>Better Proofing Tools</strong></td>
<td>If you change one of several spelling checker options in one Office program, that option is now updated in all the programs. Also, the Outlook 2007 spell checker can now recognize some contextual spelling errors—for example, the use of “their” vs. “there”.</td>
</tr>
<tr>
<td><strong>Word E-mail Editor</strong></td>
<td>The Microsoft Word program is now Outlook’s only e-mail text editor. You can no longer turn it off and use a native Outlook editor.</td>
</tr>
</tbody>
</table>
Understanding the Outlook 2007 Program Screen

The Outlook 2007 program screen may seem confusing and overwhelming at first. This lesson will help you become familiar with it.

- **Title bar**: Displays the name of the program you are currently using (Outlook) and the item you are currently working with (Inbox).
- **Menu bar**: Displays a list of menus that you use to give commands to Outlook. Clicking a menu name displays a list of commands—for example, clicking the Edit menu name displays different editing commands like Cut and Paste.
- **Standard toolbar**: Contains buttons for common commands such as creating new items, printing items, and getting help. The buttons on the Standard toolbar change depending on what you’re working on.
- **Inbox**: Folder that displays your incoming e-mail messages.

**Exercise Notes**
- **Exercise File**: None required.
- **Exercise**: Understand and experiment with the different parts of the Microsoft Office Outlook 2007 program screen.
## The Fundamentals

<table>
<thead>
<tr>
<th>E</th>
<th><strong>Instant Search:</strong> Enter key words to perform a search of message content and folders.</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td><strong>Reading Pane:</strong> Displays the selected message.</td>
</tr>
<tr>
<td>G</td>
<td><strong>Help text box:</strong> Type a question about Outlook here and press the &lt;Enter&gt; key to search Outlook Help for answers. The Outlook Help window displays the results.</td>
</tr>
<tr>
<td>L</td>
<td><strong>Navigation Pane:</strong> Contains buttons and icons you can click to move among Outlook’s folders and tools. The pane’s contents change when you click a different Navigation Pane button—i.e. Mail, Calendar, or Contacts.</td>
</tr>
<tr>
<td>M</td>
<td><strong>Mail folders:</strong> Displays all your mail folders, including the Inbox, Outbox, Junk E-mail, Drafts, and Sent Items folders.</td>
</tr>
<tr>
<td>N</td>
<td><strong>Scroll bars:</strong> Use the vertical scroll bars to view different parts of the panes.</td>
</tr>
</tbody>
</table>
### Understanding Items

In Outlook, an item is the basic element that holds information. Items are used to send and view e-mails, and also to organize information like tasks and contacts.

Since they present different types of information, different types of items differ in their appearance.

Table 3-2: Outlook Items provides an overview of items available in Outlook.

#### Table 3-2: Outlook Items

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail Message</td>
<td>Compose a message to be sent by e-mail.</td>
</tr>
<tr>
<td>Appointment</td>
<td>Add an appointment to your calendar.</td>
</tr>
<tr>
<td>Meeting Request</td>
<td>Set up an appointment to which you invite other people or reserve resources such as a conference room.</td>
</tr>
<tr>
<td>Contact</td>
<td>Enter information about a person including their name, company, job title, and e-mail address.</td>
</tr>
<tr>
<td>Distribution List</td>
<td>Create a collection of contacts that allows you to quickly send mass e-mails.</td>
</tr>
<tr>
<td>Task</td>
<td>Enter to-do items that can be tracked until completion.</td>
</tr>
<tr>
<td>Task Request</td>
<td>Inform someone else of a task you would like them to perform.</td>
</tr>
<tr>
<td>Journal Entry</td>
<td>Keep track of interactions and files that you create—such as e-mails or Word documents—in a timeline view.</td>
</tr>
<tr>
<td>Note</td>
<td>Leave yourself a note so you remember to do something. Can be sorted using color categories.</td>
</tr>
</tbody>
</table>

**Exercise**

- **Exercise File:** None required.
- **Exercise:** Explore and understand the various types of items available in Outlook 2007.
Understanding the Message Window

The mail message window, like other item windows in Outlook 2007, features the new Ribbon in place of menus and toolbars. This lesson will help you become familiar with the basic features of the message window.

Office Button and Quick Access Toolbar: The Office Button allows you to see everything you can do to your document. The Quick Access Toolbar contains common commands such as Save and Undo. You can add more commands as well.

Ribbon: The tabs and groups of commands on the Ribbon replace the menus and toolbars found in the message window in previous versions of Outlook.

Recipients: Enter the e-mail addresses of the recipients in the To field. Use the CC field to send a copy of the message to any recipients who are not directly involved, but who might be interested in the message.

Subject line: Enter a title here so that recipients quickly know the reason for your e-mail.

Send button: Click here to send the message once you’ve finished composing it.

Message Area: Type your e-mail message here as you would using a word processor.

Signature: You can create a customized signature that appears on your messages. You can include contact information and even a logo.

Scroll bar: Use the scroll bar to view different parts of a long message.

Exercise Notes

- Exercise File: None required.
- Exercise: Understand and experiment with the different parts of the Microsoft Office Outlook 2007 screen.
Understanding the Ribbon

In most of the Office 2007 programs, menus and toolbars have been completely replaced by the Ribbon. Outlook 2007 is different. Menus and toolbars remain on the Outlook 2007 program screen, while the new Ribbon appears only in item windows such as message windows. The Ribbon keeps commands visible while you work instead of hiding them under menus or toolbars.

The Ribbon is made up of three basic components:

Tabs

Commands are organized into tabs on the Ribbon. Each tab contains a different set of commands. In Outlook, there are two different types of tabs:

- **Command tabs**: These tabs appear by default whenever you open an item window. For example, in a new message window, the Message, Insert, Options and Format Text tabs appear by default.

- **Contextual tabs**: Contextual tabs appear whenever you perform a specific task and offer commands relative to only that task. For example, if you insert a table in a message, the Design and Layout tabs appear on the Ribbon.

Groups

The commands found on each tab are organized into groups of related commands. For example, the Basic Text group contains commands for formatting message text. Click the Dialog Box Launcher (瞧) in the bottom-right corner of a group to display even more commands. Some groups also contain galleries that display several formatting options.

Buttons

One way to issue a command is by clicking its button on the Ribbon. Buttons are the smallest element of the Ribbon.

Tips

- You can minimize the Ribbon so that only tab names appear, giving you more room in the item window. To do this, double-click the currently displayed command tab. To display the Ribbon again, click any tab.

- Based on the size of the item window, Outlook changes the appearance and layout of the commands within the groups.

Exercise

- **Exercise File**: None required.
- **Exercise**: Click the New button on the Standard toolbar to create a new e-mail message. Then click each tab on the Ribbon to view its commands.
Using the Office Button and Quick Access Toolbar

Near the Ribbon at the top of an item window are two other tools you can use to give commands in Outlook 2007: The Office Button and the Quick Access Toolbar.

Office Button

The Office Button appears in the upper-left corner of an item window and contains basic file management commands including New, which creates a new item; Save, which saves the current item; and Close, which closes the currently opened item.

Tips

✓ The Office Button replaces the File menu found in item windows in previous versions of Outlook.

Quick Access Toolbar

The Quick Access Toolbar appears to the right of the Office Button and provides easy access to the commands you use most frequently. By default, the Save, Undo, Redo, Previous Item and Next Item buttons appear on the toolbar; however, you can customize this toolbar to meet your needs by adding or removing buttons. To customize it:

• Click the Customize Quick Access Toolbar button at the end of the Quick Access Toolbar and select the commands you want to add or remove.

Tips

✓ You can change where the Quick Access Toolbar appears in the program window. To do this, click the Customize Quick Access Toolbar button at the end of the Quick Access Toolbar. Select Show Below the Ribbon or Show Above the Ribbon, depending on the toolbar’s current location.
The Outlook program is made up of several sets of tools and folders, each with their own separate and unique screens. You can switch between these sets of tools by using the Navigation Pane.

The Mail pane appears by default when you start Outlook, but you can display other panes by clicking different Navigation Pane buttons such as Calendar, Contacts, or Tasks.

**Switch between panes**

- Click a navigation pane button (for example, Mail, Calendar, Contacts, or Tasks) in the Navigation Pane.

  The selected pane appears.

**Other Ways to Switch Panes:**
- Click Go on the menu bar and select the pane you want to view.

Table 3-3: The Navigation Pane provides an overview of the contents of the Navigation Pane.

**Tips**

- To minimize or expand the Navigation Pane in the window, click the Minimize the Navigation Pane or Expand the Navigation Pane button at the top of the Navigation Pane.

**Exercise**

- **Exercise File:** None required.
- **Exercise:** Display and explore the Calendar, Contacts, and Tasks panes, one at a time. Then return to the Mail pane.

**Table 3-3: The Navigation Pane**

<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail</td>
<td>Compose, manage, organize, send, and receive messages.</td>
</tr>
<tr>
<td>Inbox</td>
<td>Contains all your recent incoming e-mail messages.</td>
</tr>
<tr>
<td>Unread Mail</td>
<td>Contains all your unread messages.</td>
</tr>
<tr>
<td>Sent Items</td>
<td>Stores copies of messages you have sent.</td>
</tr>
<tr>
<td>Mailbox</td>
<td>Provides a preview of your day; summarizes appointments, tasks, and new e-mail messages.</td>
</tr>
<tr>
<td>Deleted Items</td>
<td>Works like the Windows Recycle Bin; where you can find deleted Outlook items.</td>
</tr>
<tr>
<td>Drafts</td>
<td>Stores draft messages that you haven’t yet completed.</td>
</tr>
<tr>
<td>Junk E-mail</td>
<td>Contains messages that Outlook considers spam. You should check this folder periodically to check for incorrectly flagged messages.</td>
</tr>
<tr>
<td>Outbox</td>
<td>Temporarily stores any messages that you’ve composed that have not been sent.</td>
</tr>
</tbody>
</table>
### Table 3-3: The Navigation Pane

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RSS Feeds</strong></td>
<td>Allows you to access content that you’ve subscribed to via RSS feed, such as news and blogs.</td>
</tr>
<tr>
<td><strong>Search Folders</strong></td>
<td>Provides quick access to color categorized messages, messages flagged for follow-up, messages with large attachments, and unread messages.</td>
</tr>
<tr>
<td><strong>Calendar</strong></td>
<td>Enables you to view and schedule appointments, events, and meetings.</td>
</tr>
<tr>
<td><strong>Contacts</strong></td>
<td>Stores addresses, numbers, e-mail addresses, and other information about people you contact.</td>
</tr>
<tr>
<td><strong>Tasks</strong></td>
<td>Allows you to organize and manage to-do items.</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>Works like electronic sticky notes; allows you to jot down quick bits of information.</td>
</tr>
<tr>
<td><strong>Folder List</strong></td>
<td>Displays all the folders in Microsoft Outlook.</td>
</tr>
<tr>
<td><strong>Shortcuts</strong></td>
<td>Contains shortcuts (that you add yourself) to other folders, such as the My Documents folder.</td>
</tr>
<tr>
<td><strong>Configure buttons</strong></td>
<td>Allows you to add or remove buttons from the Navigation Pane.</td>
</tr>
<tr>
<td><strong>Journal</strong></td>
<td>Records information about items you send or receive and files you create (not shown by default).</td>
</tr>
</tbody>
</table>
Using the To-Do Bar

The To-Do Bar is new for Outlook 2007 and combines a basic calendar, the day’s appointments, and current tasks into one pane. It allows you to keep tabs on multiple sources of information in Outlook all at once.

Display the To-Do Bar

- Select View → To-Do Bar → Normal from the menu.
  
The To-Do Bar appears on the right-hand side of the screen.

Tips

✔ To minimize the To-Do Bar, click the Minimize the To-Do Bar button, which is located at the top of the To-Do Bar.

✔ If you click a date on the calendar in the To-Do Bar, the Calendar module is displayed on the screen.

Exercise

- Exercise File: None required.
- Exercise: Display the To-Do Bar, minimize it, and then maximize it again.
Using Menus and Toolbars

Using menus and toolbars are two good ways to give commands in Outlook. While they have been replaced by the Ribbon in item windows, they still remain on the Outlook 2007 program screen.

There are also two more tools that you can use in Outlook 2007 that make relevant commands even more readily available: contextual menus and the Mini Toolbar.

Menu bar

The menu bar is located just beneath Outlook’s title bar. The menus on the menu bar include: File, Edit, View, Go, Tools, Actions, and Help. Within each menu is a list of related commands. To issue a command using a menu:

1. Click the menu name with the mouse.
   
   The menu appears.

   **Other Ways to Open a Menu:**
   
   Press `<Alt>` and then the underlined letter in menu.

2. Select a command from the menu.

   **Tip:** Additional submenus will appear under certain menu items.

Toolbars

Outlook’s toolbars provide an even faster way to give commands. By default, the Standard toolbar appears on the program screen, displaying buttons for issuing the most commonly used commands. To give a command using a toolbar:

- Click the button on the toolbar for the command you want to issue.

**Tips**

- To display the Advanced and Web toolbars, right-click anywhere in the menu or toolbar area of the Outlook program screen and select the toolbar you want to display from the menu.

- Toolbar buttons change depending on which folder is open. For example, when the Inbox is displayed, Outlook displays message-related buttons. When Calendar is displayed, appointment-related buttons appear.

- To display a toolbar button’s description, point to the button and wait a second. A ScreenTip appears, telling you what the button does.

Exercise

- **Exercise File:** None required.

- **Exercise:** Explore the commands available under each of the menus on the menu bar, then explore the commands available on the Standard toolbar. Right-click a message in the Inbox pane to display a contextual menu.

Figure 3-10: The Menu bar.

Figure 3-11: The Standard toolbar.

Figure 3-12: The Advanced toolbar.

Figure 3-13: The Web toolbar.
**Contextual menus**

Another type of Outlook menu, a *contextual menu*, displays a list of commands related to a specific object or area. To open a contextual menu:

1. Right-click an object or area in the item window or program screen.
   A contextual menu appears, displaying commands that are relevant to the object or area you clicked.

2. Select an option from the contextual menu, or click anywhere outside the contextual menu to close it without selecting anything.

**Mini Toolbar**

New in Outlook 2007 is the *Mini Toolbar*, which appears when you select text in a new item window, and contains common text formatting commands. To view the Mini Toolbar:

1. Select text in an item window.
   The Mini Toolbar appears above the text you selected.

   - **Trap:** Sometimes the Mini Toolbar can be hard to see due to its transparency. To make the Mini Toolbar more visible, point to it.

   - **Tip:** A larger version of the Mini Toolbar also appears along with the contextual menu whenever you right-click in an item window.

2. Click the desired command on the Mini Toolbar or click anywhere outside the Mini Toolbar to close it.
Using Keyboard Commands

Another way to give commands in Outlook 2007 is using the keyboard. There are two different types of keyboard commands in Outlook 2007: keystroke shortcuts and Key Tips.

Keystroke shortcuts

Keystroke shortcuts can save time when issuing common commands, such as creating a new mail message.

In order to issue a command using a keystroke shortcut, you simply press a combination of keys on your keyboard. For example, rather than clicking the New button on the Standard toolbar to create a new mail message, you could press and hold the keystroke shortcut, <Ctrl> + <N>.

Table 3-4: Common Keystroke Shortcuts provides an overview of commonly used keystroke shortcuts.

Key Tips

New in Outlook 2007, Key Tips appear whenever you press the <Alt> key in an item window.

To issue a command using a Key Tip:

1. Press the <Alt> key.

   Tiny letters and numbers, called badges, appear on the Office Button, the Quick Access Toolbar, and all of the tabs on the Ribbon.

2. Depending on the tab or command you want to select, press the letter or number key indicated on the badge.

3. Repeat this step as necessary until the desired command has been issued.

Table 3-4: Common Keystroke Shortcuts

<table>
<thead>
<tr>
<th>Keystroke Shortcut</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Ctrl&gt; + &lt;O&gt;</td>
<td>Opens the selected item.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;N&gt;</td>
<td>Creates a new item.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;S&gt;</td>
<td>Saves the currently opened item.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;P&gt;</td>
<td>Prints the selected item.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;B&gt;</td>
<td>Toggles bold font formatting.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;I&gt;</td>
<td>Toggles italic font formatting.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;C&gt;</td>
<td>Copies the selected text or object.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;X&gt;</td>
<td>Cuts the selected text or object.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;V&gt;</td>
<td>Pastes the selected text or object.</td>
</tr>
</tbody>
</table>

Figure 3-16: Press the <Alt> key to display Key Tips.
Using Help

When you don’t know how to do something in Outlook 2007, look up your question in the Outlook Help files. The help files can answer your questions and offer tips about Outlook’s features.

Search for help

1. Click the Microsoft Office Outlook Help button on the Standard toolbar.
   The Outlook Help window appears.

   Other Ways to Open the Help window:
   Press <F1> or type a question in the “Type a question for help” box on the menu bar.

2. Type what you want to search for in the “Type words to search for” box and press <Enter>.
   A list of help topics appears.

3. Click the topic that best matches what you’re looking for.
   Outlook displays information regarding the selected topic.

Browse for help

1. Click the Microsoft Office Outlook Help button on the Standard toolbar.
   The Outlook Help window appears.

2. Click the category that you want to browse.
   The topics within the selected category appear.

3. Click the topic that best matches what you’re looking for.
   Outlook displays information regarding the selected topic.

Exercise

• Exercise File: None required.
• Exercise: Browse topics in the “What’s new” category of Help. Then search the phrase “create a new message”. Change the help source to the “Outlook Help” section under “Content from this computer” and search the term again.

Figure 3-17: The Outlook Help window.
Choose the Help source

If you are connected to the Internet, Outlook 2007 retrieves help from the Office Online database by default. You can easily change this to meet your needs.

1. Click the Search button list arrow in the Outlook Help window.
   A list of help sources appears.

2. Select an option from the list.
   Now you can search that source.

Table 3-5: Help buttons provides an overview of the buttons available in the Help window.

Tips

✓ When a standard search returns too many results, try searching offline to narrow things down a bit.

✓ Office 2007 offers enhanced ScreenTips for many buttons on the Ribbon. You can use these ScreenTips to learn more about what a button does and, where available, view a keystroke shortcut for the command. If you see the message “Press F1 for more help”, press <F1> to get more information relative to that command.

✓ When you are working in a dialog box, click the Help button ( chocolat) in the upper right-hand corner to get help regarding the commands in the dialog box.

---

<table>
<thead>
<tr>
<th>Table 3-5: Help buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
</tr>
<tr>
<td>Forward</td>
</tr>
<tr>
<td>Home</td>
</tr>
<tr>
<td>Print</td>
</tr>
<tr>
<td>Change Font Size</td>
</tr>
<tr>
<td>Show Table of Contents</td>
</tr>
<tr>
<td>Keep On Top/Not on Top</td>
</tr>
</tbody>
</table>
Exiting Outlook 2007

When you’re finished using Outlook 2007, you can exit it.

- Select File → Exit from the menu.

  The Outlook program closes.

Other Ways to Exit Outlook:
  Click the Close button on the title bar.

Tips
✓ Having too many programs open at a time can slow down your computer, so it’s a good idea to exit programs that aren’t being used.

Exercise

- Exercise File: None required.
- Exercise: Exit the Microsoft Office Outlook 2007 program.

Figure 3-18: Exiting Outlook.
Microsoft PowerPoint is a presentation program that helps you transform your ideas into professional, convincing presentations. Whether you’re delivering annual sales statistics to a large audience or creating a personal slide show of your recent trip abroad, PowerPoint has all the tools you need to get your message across.

For 2007, PowerPoint has undergone a major redesign. If you’ve used PowerPoint before, you’ll still be familiar with much of the program’s functionality, but you’ll notice a completely new user interface and many new features that have been added to make using the program more efficient.

This chapter is an introduction to working with PowerPoint. You’ll learn about the main components of the program screen, how to issue commands, use the Help feature, and all about PowerPoint 2007’s new features.
Starting PowerPoint 2007

In order to use a program, you must start—or launch—it first.

Windows XP

1. Click the Windows Start button.
   The Start menu appears.

2. Point to All Programs.
   A menu appears. The programs and menus listed here will depend on the programs installed on your computer.

3. Point to Microsoft Office.

   The PowerPoint program appears onscreen.

   Tip: Depending on how your computer is set up, the procedure for starting PowerPoint 2007 might be a little different from the one described here.

Tips

✓ If you use PowerPoint 2007 frequently, you might consider pinning it to the Start menu. If you are using Windows XP, right-click Microsoft Office PowerPoint 2007 in the All Programs menu and select Pin to Start Menu from the shortcut menu.

---

Exercise

- Exercise File: None required.
- Exercise: Start the Microsoft Office PowerPoint 2007 program.

---

Figure 4-1: The PowerPoint program window.

Figure 4-2: The All Programs menu in Windows XP.
What's New in PowerPoint 2007?

PowerPoint 2007 is very different from previous versions of the program. The table below gives you an overview of what to expect.

Table 4-1: What's New in PowerPoint 2007

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New user interface</td>
<td>Getting used to the new results-oriented user interface (UI) is the most noticeable change in PowerPoint 2007. Traditional menus and toolbars have been replaced by the Ribbon, a single mechanism that makes all the commands needed to perform a task readily available.</td>
</tr>
<tr>
<td>Live Preview</td>
<td>Allows you to preview how a formatting change will look before applying it. Simply point to the selection on the Ribbon or Mini Toolbar and PowerPoint 2007 shows you a preview of what your presentation would look like if the selected changes were applied.</td>
</tr>
<tr>
<td>XML compatibility</td>
<td>The new PowerPoint XML format (.pptx) is much smaller in file size and makes it easier to recover damaged or corrupted files. Files based on XML have the potential to be more robust and integrated with information systems and external data.</td>
</tr>
<tr>
<td>Themes</td>
<td>Themes, which replace the design templates found in previous versions of PowerPoint, let you change the overall look and feel of a presentation in just a few clicks.</td>
</tr>
<tr>
<td>Enhanced special effects</td>
<td>Now you can apply reflection, glow, bevel, and 3-D rotation effects to shapes, and warping to text and images.</td>
</tr>
<tr>
<td>Create a custom layout</td>
<td>Using PowerPoint 2007, you can create and save a custom presentation layout.</td>
</tr>
<tr>
<td>SmartArt</td>
<td>The new SmartArt graphics feature offers new diagram types and more layout options. You can even convert bulleted lists into a diagram using the SmartArt diagram tools.</td>
</tr>
<tr>
<td>Presenter view</td>
<td>Use multiple monitors to provide one view for the presenter and another for the audience. The presenter has access to upcoming slides, timing, and speaker notes, while the audience sees only the full view of the slide.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Oddly not included in previous versions of PowerPoint, the Print Preview feature finally made the cut this time around.</td>
</tr>
<tr>
<td>Save as PDF</td>
<td>Now you can save a presentation as a PDF without using third-party software. PDF format allows you to share your presentation with users on any platform. This feature requires an add-in.</td>
</tr>
<tr>
<td>Document Inspector</td>
<td>Removes comments, tracked changes, metadata (document history such as the author and editors) and other information that you don’t want to appear in the finished presentation.</td>
</tr>
<tr>
<td>Digital Signature</td>
<td>Adding a digital signature to a presentation prevents inadvertent changes, ensuring that your content cannot be altered.</td>
</tr>
<tr>
<td>Better sharing capabilities</td>
<td>Microsoft Office SharePoint Server 2007 makes it easier to share and manage presentations from within PowerPoint.</td>
</tr>
</tbody>
</table>

Exercise

- **Exercise File**: None required.
- **Exercise**: Review the new features in Microsoft Office PowerPoint 2007.
### Understanding the PowerPoint 2007 Program Screen

The PowerPoint 2007 program screen may seem confusing and overwhelming at first. This lesson will help you become familiar with the PowerPoint 2007 program screen as well as the new user interface.

<table>
<thead>
<tr>
<th><strong>Office Button</strong></th>
<th><strong>Quick Access Toolbar</strong></th>
<th><strong>Title bar</strong></th>
<th><strong>Close button</strong></th>
<th><strong>Ribbon</strong></th>
<th><strong>Slide pane</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Replaces the File menu found in previous versions of PowerPoint.</td>
<td>Contains common commands such as Save, Undo, and Print. You can add more commands as well.</td>
<td>Displays the name of the program you are using and the name of the presentation you are currently working on.</td>
<td>Click here to close the current presentation. If only one presentation is open, clicking this button will close the PowerPoint program as well.</td>
<td>The tabs on the Ribbon replace the menus and toolbars found in previous versions of PowerPoint.</td>
<td>Displays the slide you are currently working on.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Notes pane</strong></th>
<th><strong>Zoom slider</strong></th>
<th><strong>View buttons</strong></th>
<th><strong>Status bar</strong></th>
<th><strong>Outline tab</strong></th>
<th><strong>Slides tab</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type any notes you want to use during a presentation here.</td>
<td>Click and drag the slider to zoom in or out of a slide. You can also use the + and – buttons.</td>
<td>Use these buttons to quickly switch between Normal, Slide Sorter, and Slide Show views.</td>
<td>Displays information about your presentation, such as your current location in the presentation. Right-click the status bar to specify what information is shown.</td>
<td>Focuses on the content of your presentation rather than its appearance. Use the Outline tab when you want to add large amounts of text to a presentation.</td>
<td>Contains a thumbnail image of every slide in the presentation. Click a thumbnail to jump to that slide.</td>
</tr>
</tbody>
</table>

### Exercise

- **Exercise File**: None required.
- **Exercise**: Understand and experiment with the different parts of the Microsoft Office PowerPoint 2007 screen.
Understanding the Ribbon

PowerPoint 2007 provides easy access to commands through the Ribbon, which replaces the menus and toolbars found in previous versions of PowerPoint. The Ribbon keeps commands visible while you work instead of hiding them under menus or toolbars.

The Ribbon is made up of three basic components:

**Tabs**
Commands are organized into **tabs** on the Ribbon. Each tab contains a different set of commands. There are three different types of tabs:

- **Command tabs**: These tabs appear by default whenever you open the PowerPoint program. In PowerPoint 2007, the Home, Insert, Design, Animations, Slide Show, Review and View tabs appear by default.
- **Contextual tabs**: Contextual tabs appear whenever you perform a specific task and offer commands relative to only that task. For example, whenever you select a picture, a Picture Tools tab appears in the Ribbon.
- **Program tabs**: If you switch to a different authoring mode or view, such as Print Preview, program tabs replace the default command tabs that appear on the Ribbon.

**Groups**
The commands found on each tab are organized into **groups** of related commands. For example, the Font group contains commands used for formatting fonts. Click the Dialog Box Launcher (ขวา) in the bottom-right corner of a group to display even more commands.

**Buttons**
One way to issue a command is by clicking its **button** on the Ribbon. Buttons are the smallest element of the Ribbon and change color when clicked.

**Tips**
- The Ribbon shrinks or expands depending on your screen resolution and the size of the program window.
- You can hide the Ribbon so that only tab names appear, giving you more room in the program window. To do this, double-click the currently displayed command tab. To display the Ribbon again, click any tab.

**Exercise**
- **Exercise File**: None required.
- **Exercise**: Click each tab on the Ribbon to view its commands.

---

**Figure 4-3**: Elements of the Ribbon.

**Figure 4-4**: Hiding the Ribbon gives you more room in the program window.
Using the Office Button and the Quick Access Toolbar

Near the Ribbon at the top of the program window are two other tools you can use to give commands in PowerPoint 2007: The Office Button and the Quick Access Toolbar.

Office Button

The Office Button appears in the upper-left corner of the program window and contains basic file management commands including New, which creates a new file; Open, which opens a file; Save, which saves the currently opened file; and Close, which closes the currently opened file.

Tips
✓ The Office Button replaces the File menu found in previous versions of PowerPoint.

Quick Access Toolbar

The Quick Access Toolbar appears to the right of the Office Button and provides easy access to the commands you use most frequently. By default, the Save, Undo, and Redo/Repeat buttons appear on the toolbar; however, you can customize this toolbar to meet your needs by adding or removing buttons. (More on this in a later lesson.)

Tips
✓ You can change where the Quick Access Toolbar appears in the program window. To do this, click the Customize Quick Access Toolbar button at the end of the Quick Access Toolbar. Select Show Below the Ribbon or Show Above the Ribbon, depending on the toolbar’s current location.

Exercise

- Exercise File: None required.
- Exercise: Click the Office Button to open the Office Button menu. Move the Quick Access Toolbar below the Ribbon, then move it back above the Ribbon.
Using Keyboard Commands

Another way to give commands in PowerPoint 2007 is using the keyboard. There are two different types of keyboard commands in PowerPoint 2007: keystroke shortcuts and Key Tips.

Keystroke shortcuts

Without a doubt, keystroke shortcuts are the fastest way to give commands in PowerPoint 2007. They’re especially great for issuing common commands, such as saving a presentation or undoing your last action.

In order to issue a command using a keystroke shortcut, you simply press a combination of keys on your keyboard. For example, rather than clicking the Copy button on the Ribbon to copy text, you could press and hold the copy keystroke shortcut, <Ctrl> + <C>.

Key Tips

New in PowerPoint 2007, Key Tips appear whenever you press the <Alt> key. You can use Key Tips to perform just about any action in PowerPoint, without ever having to use the mouse.

To issue a command using a Key Tip, first press the <Alt> key. Tiny letters and numbers, called badges, appear on the Office Button, the Quick Access Toolbar, and all of the tabs on the Ribbon. Depending on the command you want to issue, press the letter or number key indicated on the badge. Repeat this step as necessary until the desired command has been issued.

Exercise

- **Exercise File:** None required.
- **Exercise:** Memorize some common keystroke shortcuts. Then view Key Tips in the program.

<table>
<thead>
<tr>
<th>Table 4-2: Common Keystroke Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;O&gt;</strong></td>
</tr>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;N&gt;</strong></td>
</tr>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;S&gt;</strong></td>
</tr>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;P&gt;</strong></td>
</tr>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;B&gt;</strong></td>
</tr>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;I&gt;</strong></td>
</tr>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;C&gt;</strong></td>
</tr>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;X&gt;</strong></td>
</tr>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;V&gt;</strong></td>
</tr>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;Home&gt;</strong></td>
</tr>
<tr>
<td><strong>&lt;Ctrl&gt; + &lt;End&gt;</strong></td>
</tr>
</tbody>
</table>

**Figure 4-7:** Press the <Alt> key to display Key Tips.
Using Contextual Menus and the Mini Toolbar

There are two tools that you can use in PowerPoint 2007 that make relevant commands even more readily available: contextual menus and the Mini Toolbar.

**Contextual menus**

A contextual menu displays a list of commands related to a specific object or area. To open a contextual menu:

1. Right-click an object or area of the presentation or program screen.

   A contextual menu appears, displaying commands that are relevant to the object or area that you right-clicked.

2. Select an option from the contextual menu, or click anywhere outside the contextual menu to close it without selecting anything.

**The Mini Toolbar**

New in PowerPoint 2007, the Mini Toolbar appears whenever you select text and contains common text formatting commands. To view the Mini Toolbar:

1. Select a block of text.

   The Mini Toolbar appears above the text you selected.

   ![Trap: Sometimes the Mini Toolbar can be hard to see due to its transparency. To make the Mini Toolbar more visible, point to it.](Figure 4-8: A contextual menu.)

2. Click the desired command on the Mini Toolbar or click anywhere outside the Mini Toolbar to close it.

   ![Tip: If you don’t want the Mini Toolbar to appear every time you select a block of text, click the Office Button and click the PowerPoint Options button. Click the Personalize category, uncheck the Show Mini Toolbar on selection check box, and click OK.](Figure 4-9: The Mini Toolbar.)

---

**Exercise**

- **Exercise File:** None required.
- **Exercise:** Display a contextual menu in the main area and other parts of the program window.
Using Help

When you don’t know how to do something in PowerPoint 2007, look up your question in the PowerPoint Help files. The PowerPoint Help files can answer your questions, offer tips, and provide help for all of PowerPoint’s features.

Search for help

1. Click the Microsoft Office PowerPoint Help button ( ) on the Ribbon.
   The PowerPoint Help window appears.

   Other Ways to Open the Help window: Press <F1>.

2. Type what you want to search for in the Type words to search for box and press <Enter>.
   A list of help topics appears.

3. Click the topic that best matches what you’re looking for.
   PowerPoint displays information regarding the selected topic.

Browse for help

1. Click the Microsoft Office PowerPoint Help button ( ) on the Ribbon.
   The PowerPoint Help window appears.

   Other Ways to Open the Help window: Press <F1>.

2. Click the category that you want to browse.
   The topics within the selected category appear.

3. Click the topic that best matches what you’re looking for.
   PowerPoint displays information regarding the selected topic.

Choose the Help source

If you are connected to the Internet, PowerPoint 2007 retrieves help from the Office Online database by default. You can easily change this to meet your needs.

1. Click the Search button list arrow in the PowerPoint Help window.
   A list of options appears.
2. Select an option from the list.

Tips

✓ When a standard search returns too many results, try searching offline to narrow things down a bit.

✓ Office 2007 offers enhanced ScreenTips for many buttons on the Ribbon. You can use these ScreenTips to learn more about what a button does and, where available, view a keystroke shortcut for the command. If you see the message “Press F1 for more help”, press <F1> to get more information relative to that command.

✓ When you are working in a dialog box, click the Help button (/social) in the upper right-hand corner to get help regarding the commands in the dialog box.

✓ The “Type a question for help” box that was available in previous versions of Microsoft PowerPoint is not available in PowerPoint 2007.
Exiting PowerPoint 2007

When you’re finished using PowerPoint 2007, you should exit it. Exiting a program closes it until you need to use it again.

1. Click the Office Button.

2. Click Exit PowerPoint.

The PowerPoint program closes.

Other Ways to Exit PowerPoint:
If you only have one presentation open in PowerPoint, click the Close button in the upper-right corner of the program window.

Tips
✓ Having too many programs open at a time could slow down your computer, so it’s a good idea to exit all programs that aren’t being used.

Figure 4-11: Exiting Microsoft PowerPoint.
Microsoft Word is a powerful word-processing program that gives users the tools to create a variety of professional documents. Word automatically checks your spelling and grammar and corrects common mistakes. It even lets you insert charts, tables, and pictures into your documents. Microsoft Word is the most widely used and, according to most reviews, the most powerful and user-friendly word-processor available.

This chapter is an introduction to working with Word. You’ll learn about the main parts of the program screen, how to give commands, use help, and about new features in Word 2007.
Starting Word 2007

In order to use a program, you must start—or launch—it first.

Windows XP

1. Click the Windows Start button.
   The Start menu appears.

2. Point to All Programs.
   A menu appears. The programs and menus listed here will depend on the programs installed on your computer.

3. Point to Microsoft Office.

   The Word 2007 program screen appears.

   **Trap:** Depending on how your computer is set up, the procedure for starting Word 2007 might be a little different from the one described here.

**Tips**

✓ If you use Word 2007 frequently, you might consider pinning it to the Start menu. To do this, right-click Microsoft Office Word 2007 in the All Programs menu and select Pin to Start Menu from the shortcut menu.

---

**Exercise**

- **Exercise File:** None required.
- **Exercise:** Start the Microsoft Office Word 2007 program.

Figure 5-1: The All Programs menu in Windows XP.

Figure 5-2: The Microsoft Word 2007 program window.
What's New in Word 2007

Word 2007 is very different from previous versions of the program. The table below gives you an overview of what to expect.

<table>
<thead>
<tr>
<th>Table 5-1: What's New in Word 2007</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New user interface</strong></td>
</tr>
<tr>
<td><strong>Live Preview</strong></td>
</tr>
<tr>
<td><strong>XML compatibility</strong></td>
</tr>
<tr>
<td><strong>Improved styles and themes</strong></td>
</tr>
<tr>
<td><strong>Enhanced special effects</strong></td>
</tr>
<tr>
<td><strong>SmartArt</strong></td>
</tr>
<tr>
<td><strong>Save as PDF</strong></td>
</tr>
<tr>
<td><strong>Document Inspector</strong></td>
</tr>
<tr>
<td><strong>Digital Signature</strong></td>
</tr>
<tr>
<td><strong>Better sharing capabilities</strong></td>
</tr>
<tr>
<td><strong>Macro detection</strong></td>
</tr>
</tbody>
</table>

---

**Exercise**

- **Exercise File:** None required.
- **Exercise:** Review the new features in Microsoft Office Word 2007.
Understanding the Word 2007 Program Screen

The Word 2007 program screen may seem confusing and overwhelming at first. This lesson will help you become familiar with the Word 2007 program screen as well as the new user interface.

- **Office Button**: Replaces the File menu found in previous versions of Word.
- **Quick Access Toolbar**: Contains common commands such as Save and Undo. You can add more commands as well.
- **Title bar**: Displays the name of the program you are using and the name of the document you are currently working on.
- **Close button**: Click here to close the current document. If only one document is open, clicking this button will close the Word program as well.
- **Ribbon**: The tabs on the Ribbon replace the menus and toolbars found in previous versions of Word.
- **Scroll bar**: There are both vertical and horizontal scroll bars: you use them to view and move in your document.
- **Zoom slider**: Click and drag the slider to zoom in or out of a slide. You can also use the + and – buttons.
- **Title bar**: Displays the name of the program you are using and the name of the document you are currently working on.
- **View shortcuts**: Quickly switch between Print Layout, Full Screen Reading, Web Layout, Outline, and Draft views.
- **Status bar**: Displays information about your document. Right-click it to specify which information is shown.
- **Insertion Point**: The small, blinking bar controls where document content is entered. Move the insertion point with the mouse, or the arrow keys on the keyboard.
- **Ruler**: Displays left and right paragraph intents, document margins, and tab stops. Click the View Ruler button above the vertical scroll bar to view or hide the ruler.

**Exercise**

- **Exercise File**: None required.
- **Exercise**: Understand and experiment with the different parts of the Microsoft Office Word 2007 screen.
Understanding the Ribbon

Word 2007 provides easy access to commands through the Ribbon, which replaces the menus and toolbars found in previous versions of Word 2007. The Ribbon keeps commands visible while you work instead of hiding them under menus or toolbars.

The Ribbon is made up of three basic components:

**Tabs**

Commands are organized into tabs on the Ribbon. Each tab contains a different set of commands. There are three different types of tabs:

- **Command tabs**: These tabs appear by default whenever you open the Word 2007 program. In Word 2007, the <tab names> tabs appear by default.

- **Contextual tabs**: Contextual tabs appear whenever you perform a specific task and offer commands relative to only that task. For example, whenever you select a picture, the Format tab appears in the Ribbon under Picture Tools.

- **Program tabs**: If you switch to a different authoring mode or view, such as Print Preview, program tabs replace the default command tabs that appear on the Ribbon.

**Groups**

The commands found on each tab are organized into groups of related commands. For example, the Font group contains commands used for formatting fonts. Click the Dialog Box Launcher (-launcher) in the bottom-right corner of a group to display even more commands.

**Tips**

- Based on the size of the program window, Word changes the appearance and layout of the commands within the groups.

**Buttons**

One way to issue a command is by clicking its button on the Ribbon. Buttons are the smallest element of the Ribbon and change color when clicked.

**Tips**

- You can hide the Ribbon so that only tab names appear, giving you more room in the program window. To do this, double-click the currently displayed command tab. To display the Ribbon again, click any tab.
Using the Office Button and Quick Access Toolbar

Near the Ribbon at the top of the program window are two other tools you can use to give commands in Word 2007: The Office Button and the Quick Access Toolbar.

Office Button

The Office Button appears in the upper-left corner of the program window and contains basic file management commands including New, which creates a new file; Open, which opens a file; Save, which saves the currently opened file; and Close, which closes the currently opened file.

Tips

✓ The Office Button replaces the File menu found in previous versions of Word 2007.

Quick Access Toolbar

The Quick Access Toolbar appears to the right of the Office Button and provides easy access to the commands you use most frequently. By default, the Save, Undo, and Redo buttons appear on the toolbar; however, you can customize this toolbar to meet your needs by adding or removing buttons. To customize it:

• Click the Customize Quick Access Toolbar button at the end of the Quick Access Toolbar and select the commands you want to add or remove.

Tips

✓ You can change where the Quick Access Toolbar appears in the program window. To do this, click the Customize Quick Access Toolbar button at the end of the Quick Access Toolbar. Select Show Below the Ribbon or Show Above the Ribbon, depending on the toolbar’s current location.

Exercise

• Exercise File: None required.
• Exercise: Click the Office Button to open it. Move the Quick Access Toolbar below the Ribbon, then move it back above the Ribbon.

Figure 5-5: The Office Button menu.

Figure 5-6: The Quick Access Toolbar.
Using Keyboard Commands

Another way to give commands in Word 2007 is using the keyboard. There are two different types of keyboard commands in Word 2007: keystroke shortcuts and Key Tips.

Keystroke shortcuts

Keystroke shortcuts are one of the fastest ways to give commands in Word 2007. They're especially great for issuing common commands, such as saving a document or undoing your last action.

In order to issue a command using a keystroke shortcut, you simply press a combination of keys on your keyboard. For example, rather than clicking the Copy button on the Ribbon to copy text, you could press and hold the copy keystroke shortcut, <Ctrl> + <C>.

Key Tips

New in Word 2007, Key Tips appear whenever you press the <Alt> key. You can use Key Tips to perform just about any action in Word 2007, without ever having to use the mouse.

To issue a command using a Key Tip, first press the <Alt> key. Tiny letters and numbers, called badges, appear on the Office Button, the Quick Access Toolbar, and all of the tabs on the Ribbon. Depending on the command you want to issue, press the letter or number key indicated on the badge. Repeat this step as necessary until the desired command has been issued.

Exercise

- Exercise File: None required.
- Exercise: Memorize some common keystroke shortcuts. Then view Key Tips in the program.

Table 5-2: Common Keystroke Shortcuts

<table>
<thead>
<tr>
<th>Keystroke Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Ctrl&gt; + &lt;O&gt;</td>
<td>Opens a document.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;N&gt;</td>
<td>Creates a new document.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;S&gt;</td>
<td>Saves the current document.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;P&gt;</td>
<td>Prints the document.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;B&gt;</td>
<td>Toggles bold font formatting.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;I&gt;</td>
<td>Toggles italic font formatting.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;C&gt;</td>
<td>Copies the selected text or object.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;X&gt;</td>
<td>Cuts the selected text or object.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;V&gt;</td>
<td>Pastes the selected text or object.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;Home&gt;</td>
<td>Moves the insertion point to the beginning of the document.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;End&gt;</td>
<td>Moves the insertion point to the end of the document.</td>
</tr>
</tbody>
</table>

Figure 5-7: Press the <Alt> key to display Key Tips.
Using Contextual Menus and the Mini Toolbar

There are two tools that you can use in Word 2007 that make relevant commands even more readily available: contextual menus and the Mini Toolbar.

Contextual menus

A contextual menu displays a list of commands related to a specific object or area. To open a contextual menu:

1. Right-click an object or area of the document or program screen.
   A contextual menu appears, displaying commands that are relevant to the object or area that you right-clicked.

2. Select an option from the contextual menu, or click anywhere outside the contextual menu to close it without selecting anything.

The Mini Toolbar

New in Word 2007, the Mini Toolbar appears whenever you select text and contains common text formatting commands. To view the Mini Toolbar:

1. Select a block of text.
   The Mini Toolbar appears above the text you selected.

   **Tip:** Sometimes the Mini Toolbar can be hard to see due to its transparency. To make the Mini Toolbar more visible, point to it.

2. Click the desired command on the Mini Toolbar or click anywhere outside the Mini Toolbar to close it.

   **Tip:** If you don’t want the Mini Toolbar to appear every time you select a block of text, click the Office Button and click the Word 2007 Options button. Click the Personalize category, uncheck the Show Mini Toolbar on selection check box, and click OK.

---

Exercise

- **Exercise File:** None required.
- **Exercise:** Open a contextual menu in the main area and other parts of the program window.

---

Figure 5-8: The Mini Toolbar.

Figure 5-9: A contextual menu.
Using Help

When you don’t know how to do something in Word 2007, look up your question in the Word 2007 Help files. The Word 2007 Help files can answer your questions, offer tips, and provide help for all of Word 2007’s features.

Search for help


   Other Ways to Open the Help window: Press <F1>.

2. Type what you want to search for in the Type words to search for box and press <Enter>. A list of help topics appears.

3. Click the topic that best matches what you’re looking for. Word 2007 displays information regarding the selected topic.

Browse for help


   Other Ways to Open the Help window: Press <F1>.

2. Click the category that you want to browse. The topics within the selected category appear.

3. Click the topic that best matches what you’re looking for. Word 2007 displays information regarding the selected topic.

Choose the Help source

If you are connected to the Internet, Word 2007 retrieves help from the Office Online database by default. You can easily change this to meet your needs.

1. Click the Search button list arrow in the Word 2007 Help window. A list of options appears.

Exercise

- Exercise File: None required.
- Exercise: Search the term “document margins”. Search the term again using “Content from this computer” only. Browse topics in the “Formatting” category of Help.

Figure 5-10: The Word Help window.

Table 5-3: Help buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Click here to move back to the previous help topic.</td>
</tr>
<tr>
<td>Forward</td>
<td>Click here to move forward to the next help topic.</td>
</tr>
<tr>
<td>Home</td>
<td>Click here to return to the Help home page.</td>
</tr>
<tr>
<td>Print</td>
<td>Click here to print the current help topic.</td>
</tr>
<tr>
<td>Change Font Size</td>
<td>Click here to change the size of the text in the Help window.</td>
</tr>
<tr>
<td>Show Table of Contents</td>
<td>Click here to browse for help using the Table of Contents.</td>
</tr>
<tr>
<td>Keep On Top</td>
<td>Click here to layer the Help window so that it appears behind all other Microsoft Office programs.</td>
</tr>
</tbody>
</table>
The Fundamentals

2. Select an option from the list.

Tips

✓ When a standard search returns too many results, try searching individual sources to narrow things down a bit.

✓ Office 2007 offers enhanced ScreenTips for many buttons on the Ribbon. You can use these ScreenTips to learn more about what a button does and, where available, view a keystroke shortcut for the command. If you see the message “Press F1 for more help, press <F1> to get more information relative to that command.

✓ When you are working in a dialog box, click the Help button” in the upper right-hand corner to get help regarding the commands in the dialog box.
Exiting Word 2007

When you’re finished using Word 2007, you should exit it. Exiting a program closes it until you need to use it again.

1. Click the **Office Button**.
2. Click the **Exit Word 2007** button.

   The Word 2007 program closes.

**Other Ways to Exit Word 2007:**

- If you only have one document open in Word 2007, click the **Close** button in the upper-right corner of the program window.

**Tips**

- Having too many programs open at a time could slow down your computer, so it’s a good idea to exit all programs that aren’t being used.

![Figure 5-11: Exiting Microsoft Word.](image-url)
# Index

<table>
<thead>
<tr>
<th>B</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>badges</td>
<td>57</td>
</tr>
<tr>
<td>Buttons</td>
<td>13, 28</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close button</td>
<td>11, 24</td>
</tr>
<tr>
<td>contextual menus</td>
<td>46, 58</td>
</tr>
<tr>
<td>Contextual menus</td>
<td>16, 34</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialog Box Launcher</td>
<td>13, 28</td>
</tr>
<tr>
<td>Digital Signature</td>
<td>53</td>
</tr>
<tr>
<td>Document Inspector</td>
<td>41, 53</td>
</tr>
<tr>
<td>Document window</td>
<td>54</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>e-mail</td>
<td></td>
</tr>
<tr>
<td>message window</td>
<td>27</td>
</tr>
<tr>
<td>Exit Excel</td>
<td>19</td>
</tr>
<tr>
<td>Exit Outlook</td>
<td>38</td>
</tr>
<tr>
<td>exiting</td>
<td></td>
</tr>
<tr>
<td>Word</td>
<td>61</td>
</tr>
<tr>
<td>exiting Microsoft Office PowerPoint 2007</td>
<td>49</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formula Bar</td>
<td>12</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>G</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>groups</td>
<td>43</td>
</tr>
<tr>
<td>Groups</td>
<td>13, 28</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>H</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>headings</td>
<td>11</td>
</tr>
<tr>
<td>row and column headings</td>
<td>11</td>
</tr>
<tr>
<td>help</td>
<td>47</td>
</tr>
<tr>
<td>browsing for help</td>
<td>47</td>
</tr>
<tr>
<td>choosing a source</td>
<td>47</td>
</tr>
<tr>
<td>searching for help</td>
<td>47</td>
</tr>
<tr>
<td>Help</td>
<td>25</td>
</tr>
<tr>
<td>browse for help</td>
<td>17, 36</td>
</tr>
<tr>
<td>browsing</td>
<td>59</td>
</tr>
<tr>
<td>choose source</td>
<td>17, 36</td>
</tr>
<tr>
<td>choosing help source</td>
<td>59</td>
</tr>
<tr>
<td>getting help</td>
<td>17, 36</td>
</tr>
<tr>
<td>Help button</td>
<td>60</td>
</tr>
<tr>
<td>Press F1 for more help</td>
<td>60</td>
</tr>
<tr>
<td>ScreenTips</td>
<td>60</td>
</tr>
<tr>
<td>search for help</td>
<td>17, 36</td>
</tr>
<tr>
<td>searching</td>
<td>59</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbox</td>
<td>24</td>
</tr>
<tr>
<td>Insertion Point</td>
<td>54</td>
</tr>
<tr>
<td>Instant Search</td>
<td>25</td>
</tr>
<tr>
<td>interface</td>
<td>53</td>
</tr>
<tr>
<td>items</td>
<td>26</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>K</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Tips</td>
<td>15, 35, 45, 57</td>
</tr>
<tr>
<td>keystroke shortcuts</td>
<td>15, 35, 45</td>
</tr>
<tr>
<td>Keystroke shortcuts</td>
<td>57</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>L</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Preview</td>
<td>41, 53</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>M</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>macro detection</td>
<td>53</td>
</tr>
<tr>
<td>Mail</td>
<td></td>
</tr>
<tr>
<td>message window</td>
<td>27</td>
</tr>
<tr>
<td>Mail folders</td>
<td>25</td>
</tr>
<tr>
<td>Menu bar</td>
<td>24</td>
</tr>
<tr>
<td>about</td>
<td>33</td>
</tr>
<tr>
<td>Message Area</td>
<td>27</td>
</tr>
<tr>
<td>message window</td>
<td>27</td>
</tr>
<tr>
<td>Microsoft Office Excel 2007</td>
<td></td>
</tr>
<tr>
<td>Exiting the program</td>
<td>19</td>
</tr>
<tr>
<td>new features</td>
<td>10</td>
</tr>
<tr>
<td>starting the program</td>
<td>9</td>
</tr>
<tr>
<td>Microsoft Office Outlook 2007</td>
<td></td>
</tr>
<tr>
<td>Exiting the program</td>
<td>38</td>
</tr>
<tr>
<td>new features</td>
<td>22</td>
</tr>
<tr>
<td>starting the program</td>
<td>21</td>
</tr>
<tr>
<td>Microsoft Office PowerPoint 2007</td>
<td></td>
</tr>
<tr>
<td>exiting the program</td>
<td>49</td>
</tr>
<tr>
<td>starting the program</td>
<td>40</td>
</tr>
<tr>
<td>Mini Toolbar</td>
<td>16, 34, 46, 58</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>N</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name box</td>
<td>11</td>
</tr>
<tr>
<td>Navigation Pane</td>
<td>25</td>
</tr>
<tr>
<td>about</td>
<td>30</td>
</tr>
<tr>
<td>Navigation Pane Buttons</td>
<td>24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>O</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office Button</td>
<td>11, 14, 27, 29, 44, 54, 56</td>
</tr>
<tr>
<td>Outlook items</td>
<td>26</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>53</td>
</tr>
<tr>
<td>presenter view</td>
<td>41</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Q</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Access Toolbar</td>
<td>11, 14, 27, 29, 44, 54, 56</td>
</tr>
<tr>
<td>customizing</td>
<td>44</td>
</tr>
<tr>
<td>Customizing</td>
<td>14, 29</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R</th>
<th>Index items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading Pane</td>
<td>25</td>
</tr>
</tbody>
</table>
Recipients 27
Ribbon 11, 27, 43, 54, 55
  buttons 55
  groups 55
  tabs 55
Ribbon, the 28
Ruler 54

S
Scroll bar 27, 54
Scroll bars 12, 25
Send button 27
SharePoint 53
shortcuts 35, 45
Signature 27
SmartArt 41, 53
Standard toolbar 24
Start button 9, 21
starting 52
starting Microsoft Office PowerPoint 2007 40
Status bar 11, 24, 54
Subject line 27

T
tabs 43
  command 43
  contextual 43
  program 43
Ruler 54
Tabs 13, 28
  Command tabs 13, 28
  Contextual tabs 13, 28
  Program tabs 13
themes 41
Title bar 11, 24, 54
To-Do Bar 24
toolbars about 33

V
views presenter 41

X
XML compatibility 53

Z
Zoom slider 12, 54